
File Menu

Dancer DNA’s creations are kept in documents which can be opened, closed, and saved under the File menu just like 
ordinary documents.    Each document contains a population.    To animate or evolve a population, open a ‘pops’ folder 
and choose a parent population. 

All the creations kept in ‘Pops’ folders have already evolved through many generations, and some have achieved 
great complexity.

To ensure smooth results on less powerful machines, each of the pops directories that come with Dancer DNA 
corresponds to a specification combining processor speed and RAM.    Dancer DNA will automatically default to the 
correct folder.    However, the only penalties in opening a more complex population are speed - and the likelihood of 
running out of RAM.

Each of the populations that comes with Dancer DNA is a different species.    These can then be evolved to create 
new populations.

Open...

Opens or finds a population.    As Dancer DNA’s populations live on quite significant amounts of RAM, we recommend 
you keep as few populations open at the same time as possible.

New

Creates an empty population.

This population can then be filled using the Paste command to load evolved creations from the clipboard.

Save

Saves the active population with its current filename and location.

Save As...

Saves the active population with the filename and location you specify.

Import & Export

These are advanced features that allow you - with a little programming experience - to genetically engineer your own 
species.    Support is available from the Dancer DNA website: http://www.dancerdna.com.

Save Music Style

Saves the dance settings of the currently selected music style.

Save Music Style As...

Saves the dance settings of the currently selected music style under a different name.

Delete Music Style

Permanently deletes the currently selected music style.



Edit Menu

Just as with ordinary documents you can copy, cut, and paste between populations.    This can be very useful in 
generating new animation populations.

As in nature, however, Dancer DNA cannot mix species.    Each of the original populations that come with Dancer 
DNA is a separate species.    We would not recommend mixing them - although to do so can, very rarely, create some 
interesting effects.

Copy

Copies selected members of the active population onto the clipboard.

Cut

Removes selected members of the active population and places them on the clipboard.

Paste

Adds the contents of the clipboard to the active population.



View Menu

The texture picker allows you a choice of eight designs to texture your Dancer DNA interface.    Most of these use a 
significant amount of RAM, so if you’re using a machine with just 16MB we strongly recommend you used only the 
default Blue - Low RAM choice.

To improve download times, internet versions of Dancer DNA come with only one texture.    However, you can 
download the other textures separately from the Dancer DNA website (www.dancerdna.com).



Animate Menu

With the Animate menu you set Dancer DNA populations dancing to your own music CDs.

To get started:

1.    Open a population from the ‘File’ menu by clicking on ‘Open’ and selecting a .pop file from the ‘pops’ folders.    
This may take a few moments.

2.    Indicate what kind of music you’ll be playing by making a selection under the ‘Music Style’ control on the Animate 
toolbar.    If that exact type of music is not available select a similar style or choose ‘Default’.

3.    Click ‘Animate’.    The Animate dialog will now open and Dancer DNA will automatically start generating a 
genespace for the animation.

4.    Place your chosen audio CD in your CD-ROM drive and click CD Player on the Animate dialog.    (Dancer DNA 
will also work with MP3 players and Line-in feeds.)

5.    If your computer’s audio-CD player does not automatically open after a few moments, click the ‘Launch Audio CD’ 
button on the Animate dialog.

6.    When the GO button becomes live, press play to set your audio CD playing, and press OK.    Dancer DNA will 
now launch the dance.

7.    To return from the dance press ‘Escape’.

Hint:    If your animation is a speck in the distance, you could try changing the sensitivity boost, or you may need to 
configure your Windows Volume Control.

The menu options act as follows:

Animate...

Launches the Animate dialog and creates a genespace through which the population will dance.    You will be offered 
the choice of driving the animation by either music from an audio CD or from an MP3 Player.    Please use these 
buttons to launch your sound source.

If a population is responding sluggishly, then either the genespace is too large and is being partially stored in virtual 
memory, or the population is too complex.

If it’s the former the dance will ‘stick’ as the hard disc is accessed.    To prevent this you should reduce the number of 
frames (see below).

If the response is always sluggish, then the population is probably too complex.    Try choosing populations from a 
lower specced folder.

A faster processor - and/or a 3D graphics card - will also significantly increase the speed of an animation.

Number of Frames...

Sets the size of the genespace, i.e. how many creatures are created for an animation. 

The higher the number, the smoother the animation.    But there is a corresponding increase in the amount of RAM 
required.

Allowing twenty frames per member of the animation population is a good - but rough and ready - compromise.    
Increasing the number would generate a smoother animation but is likely to result in a reduction in the size - and thus 
diversity - of the animation population because of RAM limitations.



Press ‘Enter’ when you have set a value.

Dance Settings...

Launches the Dance Settings dialog.    This provides you with the controls to closely link your animation to your music 
by tweaking the settings of the currently selected music style.

Real Time Music Styles...

Launches the Real Time Music Styles dialog which allows you to select ‘Real Time Music Styles’.    These are styles 
which can be loaded in ‘real time’, i.e. while your creature is dancing.    They allow you to change the way a creature 
is dancing without having to return to windows.

Default Settings

Sets settings to default values automatically calculated from the power of your computer.    Should be a safe bet for a 
smooth dance.

Redo Benchmark

If you have upgraded your computer, please use this command to prompt Dancer DNA to update its information on 
your configuration.

Automatic Source Selection

Toggles Automatic Source Selection on and off (the default is on).

When used with the CD Player and MP3 Player options on the Animate dialog, the Automatic Source Selection 
feature sets the correct Windows Volume Control settings.

You may want to dispense with this feature if you are setting your own values.



Evolve Menu

Creates the next generation of the active population by mutating the selected members.

Although Dancer DNA comes with a selection of ready to animate populations, you can also create your own.    With 
the Evolve controls you can make animation populations by evolving lifeforms.    These can then be set dancing with 
the Animate toolbar.

To get started:

1.    Open a population from the ‘File’ menu by clicking on ‘Open’ and selecting a .pop file from the ‘pops’ directories. 

2.    Select a creature from which you wish to generate the next generation by left-clicking on the creature's grey 
border.    The border should turn blue to signify a selected creature.

Hint: To select more than one creature hold down either the shift or control button.    You can also select a group of 
creatures by dragging the mouse from one of the grey borders with the left mouse button held down, over all of the 
creatures you wish to select.

Hint: Double-clicking on a creature will throw that creature up to full screen.    Press ‘Escape’ or double-click again to 
return to your population.

3.    To create the next generation through mutation click the mutate button on the Evolve toolbar.    To create the next 
generation through breeding click the breed button on the Evolve toolbar (you will need to have more than one 
creature selected in order to use breed).    Your selection’s ‘children’ will now replace their parents’ generation and you 
will have evolved the population through one generation.

Hint: The severity of the mutation between generations is controlled with the mutation factor slider bar.    This runs 
from zero to 100.    Set to zero, the children will exactly resemble their parents.    Set to 100, they will be radically 
different.

4.    Continue evolving the population by repeating steps two and three until you have created the creatures you wish 
to set dancing to music. 

Hint: You can copy and paste your new creations into a new population just as in an ordinary document.    Select 
them, then copy them with the copy command, and paste them into a new document.

Hint: 'Add' adds new and un-evolved members to the active population.    By then mutating some evolved members of 
the population you can - by using add -    increase the size of the population.

Hint: Use the 'Parents' pop-up menu to choose whether parents survive into next generation ('Keep') or are killed off 
('Cut').



Window Menu

Dancer DNA population windows are like any other document window, and can be arranged as tiles or cascaded to 
provide views of all open populations.



Help Menu

Displays explanatory material either as context sensitive help or as a list of help topics.



Animate button

Launches the Animate dialog and creates a genespace through which the population will dance.    You will be offered 
the choice of driving the animation by either music from an audio CD or from an MP3 Player.    Please use these 
buttons to launch your sound source.

To get started please see the help for the Animate menu.

If a population is not responding sluggishly, then either the genespace is too large and is being partially stored in 
virtual memory, or the population is too complex.

If it’s the former the dance will ‘stick’ as the hard disc is accessed.    To prevent this you should reduce the number of 
frames (see below).

If the response is always sluggish, then the population is probably too complex.    Try choosing populations from a 
lower specced folder.

A faster processor - and/or a 3D graphics card - will also significantly increase the speed of an animation.



Music style

Each music style presented in the selection box sets a number of triggers which control how animations respond to 
the music.    One style might, for example, set the animation to evolve on the bass-line, rotate on the vocal, and move 
with the volume.

Each style has been optimised for a particular type of music.    However, each track is different, and if the obvious 
style is not working just try another.    If your type of music is not mentioned, again, just try another suitable style.

You can also create your own styles.    Dancer DNA allows you to closely tie your animations to your music through 
creating your own music styles.    You can make changes to the currently selected style by pressing the Dance 
Settings button.    You can then save your changes under the same name or create an new style using the 'Save As...' 
option under the File menu.



Dance button

Launches the Dance Settings dialog.    This provides you with the controls to closely link your animation to your music 
by tweaking the settings of the currently selected music style.

With the morph control you can set the trigger for the creature to evolve.    The Zoom, Spin, and Stability controls 
determine its movement to the music.



Default button

Sets settings to default values automatically calculated from the power of your computer.    Should be a safe bet for a 
smooth dance.



New

Creates an empty population.

This population can then be filled by using the Paste command to call evolved creations from the clipboard.



Open

Opens or finds a population.    As Dancer DNA’s populations require quite significant amounts of RAM to live on we 
recommend you keep as few populations open at the same time as possible.



Save

Saves the active population with its current filename and location.



Save as

Saves the active population with the filename and location you specify.



Copy

Copies selected members of the active population onto the clipboard.



Cut

Removes selected members of the active population and places them on the clipboard.



Paste

Adds the contents of the clipboard to the active population.



What’s this?

Provides context sensitive help.    Place the ? cursor over any feature and click.    The help system should then 
provide an explanation of that feature.



Help

Provides a list of help topics in a searchable form.



Mutate

Creates the next generation of the active population by mutating the selected members.

The severity of the mutation can be controlled by setting the mutation factor.



Breed

Creates the next generation of the active population by breeding the selected members.

You'll need to choose at least two creatures to breed with.



Mutation factor

Sets the severity of mutation between generations.

In Dancer DNA the amount of change between generations caused by mutation can be controlled by adjusting the 
Mutation Factor.    Setting the slider to the left reduces the amount of change caused by mutation, while setting it to 
the right increases it.

Like in the natural world, however, most mutations are damaging.    If memory allows, keep populations of nine or 
more to avoid the disappointment of damaging mutations.



Add

Adds new and un-evolved members to the active population.    By then mutating some evolved members of the 
population you can - by using add -    increase the size of the population.



Population document

Dancer DNA’s populations are like other documents.    You can cut and paste between them, minimize, and maximise 
them.

Dancer DNA’s populations live on processing power and RAM so we recommend you keep as few of them open at 
once as possible - especially when generating animations.



Status bar

Status bar



Number of frames

Sets the size of the genespace, i.e. how many creatures are created for an animation. 

The higher the number, the smoother the animation.    But there is a corresponding increase in the amount of RAM 
required.

Allowing twenty frames per member of the animation population is a good - but rough and ready - compromise.    
Increasing the number would generate a smoother animation but is likely to result in a reduction in the size - and thus 
diversity - of the animation population because of RAM limitations.

Press ‘Enter’ when you have set a value.



Dancer DNA

There is no help associated with this item.    To start using Dancer DNA, see the following:

Getting started with animations.

Getting started with evolving your own populations.



Morph tab

These controls connect the evolution of a population to music.

Morph speed

Determines the maximum speed at which a species travels through genespace.    We usually use values between 10 
and 35.

Morph acceleration

Determines how much a music pulse accelerates - or ‘pushes’ - a species through genespace.    Low values - below 
10 - create a smother acceleration while higher values provide a more direct response to the music.

Music Channel

Connects a music channel [e.g. the baseline] to the journey a species takes through genespace so that it accelerates 
whenever the selected music channel is triggered. 

The sensitivity slider controls the sensitivity of the music channel while the threshold sets the value above which the 
channel is triggered.    Between them they determine how frequently and how powerfully the music channel is 
triggered.



Zoom tab

Zoom Factor

Sets the speed at which a creature moves towards - or away from -    the screen when triggered by a music channel 
such as the volume.    Lower values - below 10 - generate more gentle animations.

Music Channel

Connects the distance of a creature from the screen to a music channel so that it pulses forward whenever the 
selected music channel is triggered.

The sensitivity slider controls the sensitivity of the music channel while the threshold sets the value above which the 
channel is triggered.    Between them they determine how frequently and how powerfully the music channel is 
triggered.



Spin tab

Sets the minimum and maximum values for a creature’s speed of rotation

Maximum Speed

Sets the minimum speed of a creature’s rotation.    Values above 30 can get pretty wild.

Minimum Speed

Sets the maximum speed of a creature’s rotation.    This should be set low.    A setting of 0 can create very gentle 
animations.

Music Channel

Connects the distance of a creature from the screen to a music channel so that it pulses forward whenever the 
selected music channel is triggered.

The sensitivity slider controls the sensitivity of the music channel while the threshold sets the value above which the 
channel is triggered.    Between them they determine how frequently and how powerfully the music channel is 
triggered.



Stability tab

Stability

Controls how violently a creature twists and turns to the music.

Music Channel

Connects the rotation of a creature to a music channel so that it twists and turns whenever the selected music 
channel is triggered.

The sensitivity slider controls the sensitivity of the music channel while the threshold sets the value above which the 
channel is triggered.    Between them they determine how frequently and how powerfully the music channel is 
triggered.



Animate dialog

Creates a genespace through which the population will dance and offers you the choice of driving the animation by 
either music from an audio CD or from an MP3 Player.    Please use these buttons to launch your sound source.

The GO button only comes ‘live’ once the genespace is built.    Please ensure you have some music running before 
clicking it.    Without music the animations are just an unevolving    speck in the distance.

If your animation looks like this even with music playing, you could try changing the sensitivity boost, or you may 
need to configure your Windows Volume Control.

To return from an animation press Esc.



The Volume control

Most computers are already set-up to run Dancer DNA.    Some are not.    If an animation seems simply to be a speck 
in the distance, then you have one of the latter.    It’s easy, however, to configure them.

Dancer DNA needs to hear the sound passing over your soundcard to get your animation dancing.    To do so it uses 
the standard Windows Volume Control. If your animations are not dancing, follow these steps.

To automatically configure the Volume Control:

1.    Ensure that Automatic Source Selection is ticked under the Animate menu.

2.    Use the CD Player or MP3 Player options on the Animate dialog.

To manually configure the Volume control:

1.    Select the Volume Control under the Start menu.    It’s found under Programs, then Accessories, then Multimedia 
under Windows 95 or Entertainment under Windows 98.

2.    If you can hear your music coming through the computer when you play an audio CD please move on to step 
four.    If not, select Properties under the Options menu and ensure that the Playback button is selected and that both 
the CD Audio and Playback Controls check boxes are ticked.    Click OK.

3.    With your audio CD playing adjust the slider controls for Playback Balance and CD Audio Balance to a 
comfortable volume.    Check that neither of the mute tick boxes are selected.

4.    Select Properties under the Options menu and select the Recording button.    Tick the CD Audio check box and 
click OK.

5.    Ensure that CD Audio check box is selected and that its slider is about two-thirds of the way up.

Dancer DNA should now dance.    If the results are still disappointing it you may need to boost Dancer DNA's 
sensitivity.    You can do this with the sensitivity boost.



Selection

Selection pushes evolution remorselessly on.    In the world of flesh and blood, the grim reaper marks out who lives to 
pass on their genes, and who dies.    But in Dancer DNA it is you, the user, who decides which genes survive into the 
next generation.

Dancer DNA invites your aesthetic sense to perform the function of natural selection.    You select a creature who 
genes you wish to survive by left-clicking with your mouse on the creature's grey border. The image will then be 
bounded by a blue box. Hold down shift or control while doing this to select several creatures.

To retain a sense of continuity down the generations select one to two.    By default Dancer DNA will retain your 
selected creatures - the parents - into the next generation.    You can stop them from carrying over by choosing the 
Cut Parents option under the Evolve menu.



Sensitivity Boost

If, after trying several music styles, your creature is still not being stimulated enough by the music then one easy 
solution is to increase the sensitivity boost.

But first, if your creature is just a speck in the distance, it's worth checking that Dancer DNA is receiving a sound feed. 
You can do this by pressing F11 while the animation is in full screen and the music is playing.    You should see a set 
of numbers in green.    Are they changing?    If so, Dancer DNA is receiving a music feed, and you should read on.    If 
not, you should set the Windows Volume Control.

To get rid of the green numbers hit F11 again.

To increase the sensitivity boost you should press the Up-Arrow key on your computer while the creature is dancing. 
The longer you hold it down, the more the boost increases.    The creature's behaviour should become more 
expressive.

You can also decrease the sensitivity boost by holding down the Down-Arrow key.

You can return to the default sensitivity boost by pressing the Home key on your keyboard.

If you still cannot achieve the desired result then you may need to increase the recording volume settings under the 
Windows Volume Control or try a different music style.



Real Time Music Styles Dialog

This dialog lets you select ‘Real Time Music Styles’.    These are styles which you can load during a dance, by simply 
pressing function keys on your keyboard.

You can nominate four styles to be Real Time Styles.    The F5 to F8 keys load these styles during a dance.    Also, the 
F4 key returns you to the style which you oringinally selected before animating.

The dialog has four combo-boxes which allow you to nominate the four styles you want to be Real Time Styles.    
Press the down-arrow at the right of a combo-box to view the list of styles, and click on one of the styles to nominate 
it.    When you are happy with your nominations, press OK.    Alternatively, press Cancel to undo your nominations.



MP3 Players

Dancer DNA has always worked with MP3 players, but previously it was a real hassle to configure Windows to record 
from Wav inputs.    Dancer DNA now does this automatically for when you select the MP3 option.

If you do have any problems, and Dancer DNA does not seem to be receiving a sound feed, you can still configure 
Windows manualy.    In Volume Control, select recording under Options, Properties, and then ensure either 
wav/synth, mixer out, master out, stereo mix out or wave record balance are selected.

 




